Chapter 1

.

Introduction
1.1 What is ILWIS for Windows
ILWIS is a Windows-based, integrated GIS and Remote Sensing application
consisting of:
n
Display of raster and multiple vector maps in map windows
n
Display of tables in table windows
n
Interactive retrieval of attribute information
n
Image processing facilities
n
Manipulation of maps in a Map Calculator
n
Manipulation of tables in a Table Calculator
n
GIS analysis tools
n
Script language to perform 'batch' jobs
ILWIS functionality for vectors includes: digitizing with mouse and/or digitizer,
interpolation from isolines or points, calculation of segment or point density,
pattern analysis.
ILWIS functionality for raster includes: distance calculation, creation of a Digital
Elevation Model (DEM), calculation of slope/aspect, deriving attribute maps,
classifying maps, manipulating maps with iff-statements, with Boolean logic,
crossing maps, etc.
For satellite imagery: creation of histograms, color composites, sampling and
classification, filtering, multi-band statistics.
Furthermore ILWIS provides import and export routines, editing of point, segment,
polygon and raster maps, change of projection/coordinate systems of maps, and
output possibilities with annotation.
With Windows, you can start one operation and keep it running while you start one
or more additional applications. This is a sort of multitasking. You may work with
both Windows and DOS application programs, you can perform one or more
ILWIS calculations in the background and at the same time display maps, run other
ILWIS operations, print, etc.
ILWIS 2.1 for Windows is designed for Windows 3.1, Windows 3.11 and Windows
for Workgroups. ILWIS 2.1 for Windows also runs under Windows '95 and under
Windows NT. To install ILWIS 2.1, see Installation Guide.
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1.2 When you are new to Windows
When you are new to Windows you might have to learn some basic Windows
terminology and techniques. To acquaint yourself with Windows you can run the
Windows Tutorial and read parts of the Windows User's Guide.
The following Windows terms and techniques should be familiar to you:
minimize, maximize, moving windows, sizing windows, title bar, menu bar, using
scroll bars, using menus.

1.2.1 Windows features introduction
To learn and practice basic Windows functions, it is recommended to run the
Windows Tutorial, included in your Windows program. The Windows Tutorial can
be found on the Help menu of Windows Program Manager. It is also recommended
to read the MS Windows User's Guide.
The map windows, table windows etc., in which ILWIS displays data, have some
common Windows features:
Moving a window
A window can be moved over your desktop by dragging the title bar of a window to
a new position: place the mouse pointer on the title bar, press the left mouse button
and hold it down, and move the mouse pointer to a new position, then release the
left mouse button.
Changing the size and shape of a window
A window can be sized by dragging its borders. Select the window you want to
resize, point to a border or a corner of a window, the cursor changes into a twoheaded arrow, drag (press the left mouse button and hold it down) the border or
corner until the window is the size you want, then release the mouse button.
A window cannot be resized when a map or table is already entirely displayed in a
window. Resizing a window is possible when the border of a window consists of
double lines.
Maximize
A window can be enlarged to the full size of your screen:
n
by clicking the maximize button (the delta-up button at the upper-right corner
of a window), or
n
by clicking the Control-menu box in the upper-left corner of a window to open
the Control menu, select the Maximize command, or
n
by double-clicking the title bar of a window.

2

ILWIS Reference Guide

Introduction
To restore a window, double-click the title bar again. When two or more windows
are open and you maximize one of them, all the others are covered up by the
maximized one.
Restoring a window to its previous size: (after maximize)
A window is restored to its previous size by clicking the restore button, i.e. the
double-delta button at the upper-right corner of a maximized window. You can also
restore a window to its previous size by double-clicking the title bar. Another way is
to click the Control-menu box and select Restore from the menu.
Minimize
A window can be reduced to an icon on the desktop if you want the window or
application available for later use. To reduce a window to an icon:
n
click the minimize button (the delta-down button at the upper-right corner of a
window), or
n
click the Control-menu box in the upper-left corner of the window to open the
Control menu, select the Minimize command.
After a window is reduced to an icon, you can select and move the icon in the same
way you select and move a window. See also: icons of minimized ILWIS windows.
Restoring an icon: (after minimize)
An icon can be restored to a window by double-clicking it. You can also click the
minimized icon and select Restore from the Control menu.
Using scroll bars
When an ILWIS map or table cannot be entirely displayed in a window, scroll bars
appear at the right and/or bottom of the window. You may have both a horizontal
and vertical scroll bar or only one of them, depending on the size of your map/table
in the window. You can use the scroll bars to view information that does not fit in
the window.
The buttons with the arrows are called scroll arrows, the area between the scroll
arrows is called the scroll bar, and the button in the scroll bar is called the scroll
box. The best ways to use the scroll bars in ILWIS are:
n
Click above or below the scroll box on the vertical scroll bar: the contents of the
window will scroll vertically.
n
Click to the left or right of the scroll box on the horizontal scroll bar: the
contents of the window will scroll horizontally.
n
Drag the scroll box in a scroll bar to the position you want. The section of the
map/table that moves into view depends on where you position the scroll box.
For example, if you position the scroll box half way down the vertical scroll bar,
the contents halfway the map/table appears.
Using scroll bars can be convenient when you have zoomed in on a map.
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Closing a window
A window can be closed:
n
from the File menu, choose Exit,
n
by double-clicking the Control-menu box,
n
from the Control menu, choose Close, or
n
by pressing Alt+F4 on the keyboard.
When you close the ILWIS Main window, you will close all ILWIS windows and
leave ILWIS. When you close an ILWIS data window, you close the window in
which a map, table, or pixel information is displayed.

1.2.2 Parts of a window
Most windows have certain elements in common, such as a title bar and a menu
bar. Not all windows, however, have every element.
The Control-menu box is in the upper-left corner of each window. Click the
Control-menu box to open the Control menu. The Control menu is most useful if
you use the keyboard rather than the mouse to move, size, and close a window.
The title bar shows the name of the application, map, or table. If more than one
window is open, the title bar of the active window has a color and intensity different
from other title bars.
The menu bar contains available menus from which you can choose commands.
The scroll bars enable you to move through a map or table when the entire map or
table does not fit in the window. Click the scroll arrows with the mouse to move
through a map or table.
Clicking the Maximize button with the mouse enlarges the active window so that it
fills the entire desktop; clicking the Minimize button reduces your window to an
icon. You can also use the Maximize and Minimize commands in the Control
menu.
The Restore button replaces the Maximize button after you enlarge a window.
Clicking the Restore button returns the window to its previous size. You can also
use the Restore command in the Control menu.
The window border is the outside edge of a window. You can change the size of a
window by lengthening or shortening the border on each side of a window. You can
only resize a window when just a part of the map or table is displayed in a window.
Moving the window corner shortens or lengthens two adjoining sides of a window
border at the same time. You can only resize a window when just a part of the map
or table is displayed in a window.
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The insertion point (a flashing vertical bar) marks the place where text appears
when you begin typing.
The mouse pointer or cursor appears if you have a mouse installed. When you move
the mouse, the position of the pointer changes on the screen. The shape of the
pointer/cursor may vary, e.g. normally an arrow, but a little hand when in a map
editor.
The status line is shown at the bottom of a window. The status line gives short
clues on menu commands, on the effect of buttons in the button bars, and in some
cases displays additional information on actions in a window.
See also section 1.2.1 Windows features introduction.

1.2.3 Using a menu
Open a menu by clicking a name of a menu in the menu bar. The items displayed
on a menu are called commands. You can click the menu item you want to use.
You can also drag the mouse pointer down the menu until the menu item is
highlighted and then release the mouse button. While selecting a menu command,
the status line gives a short explanation on the effect of the command.
F

To move directly to a command on a menu, type the letter that is underlined in the
command name.
Menu conventions
Dimmed menu commands.
You cannot use the menu command at the current time. (For example, you may
need to select another item before you can use this command.)
An ellipsis (...) following a command.
A dialog box appears when you choose the command. The dialog box contains
options you need to select before the command can be carried out.
A check mark (√) to the left of a command.
The command is in effect. When you remove the check mark (by choosing the
command again), the command is no longer in effect.
A key combination (e.g. CTRL+I ) to the right of a command.
The key combination is a shortcut for choosing the command. You can press the
keys listed to choose the command without first opening the menu. (CTRL+I
means Zoom In on a map window.)
A triangle ( ) to the right of a command.
When you choose this command, a cascading menu or submenu appears.
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Context-sensitive menus
A context-sensitive menu lists commonly used menu commands. Selecting a
command from a context-sensitive menu is a short cut for selecting a normal menu
command.
In ILWIS, a context-sensitive menu appears by clicking the right mouse button
when the mouse pointer is located:
n
on an object in the Catalog: lists commands to display, edit, copy, delete the
object or to view and edit the properties of an object, allows you to obtain short
Help on this object, and lists the operations which can be performed on the
object.
n
on an operation in the Operation-list: allows you to start the operation, or to
obtain short Help on this operation.
n
in a map window: gives some short cuts to Select an area in a map, to go to
Layer Management, or to change the Double-click action. Further, all data
and/or annotation layers used in that map window are listed: select a layer to
change its display options.
n
in an editor: lists editor-related actions.

1.2.4 Control menu
With the Control menu you can close, minimize or maximize a window, restore an
icon to a window etc., The Control menu is especially convenient if you use the
keyboard rather than the mouse. Open the Control menu for a window by selecting
the Control-menu box in the upper-left corner of a window, or press Alt+Spacebar
on the keyboard. For an icon, you open the Control menu by selecting the icon.
Control menu commands
Restore
Restore a window to its former size after you have enlarged
(maximized) it or reduced (minimized) it to an icon.
Move
Move the window to another position by using the keyboard.
Size
Change the size of the window by using the keyboard.
Minimize
Reduce the window to an icon.
Maximize
Enlarge a window to its maximum size.
Close
Close the window. If you close the ILWIS Main window, you close all
ILWIS data windows and you exit ILWIS.
Switch to ... Open Task List, which enables you to switch between running
applications and to rearrange windows and icons on your desktop.
ILWIS
Switch to ILWIS Main window.
When you double-click the Control-menu box in the ILWIS Main window, you
close all ILWIS windows and you exit ILWIS. When you double-click the Controlmenu box in an ILWIS data window, you close that data window. When you
double-click an icon, the icon is restored to a window.
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1.2.5 Using a dialog box
A dialog box appears when you need to supply additional information to complete a
task.
Most dialog boxes contain options you can select. After you specify options, you can
choose the OK button to carry out the command. Some dialog boxes may display
information, warnings, or messages indicating why a requested task cannot be
accomplished. You can move a dialog box to another location on the screen by
dragging its title bar.
To move within a dialog box
The currently selected option within a dialog box appears as a highlight, a dotted
rectangle, or both.
To move to another option in a dialog box
n
click the option or area with the mouse, or
n
press Tab to move to the next, or Shift+Tab to move to the previous option or
area.
If the option, box, or button has an underlined letter in its name, you can choose
that item by pressing and holding down Alt while typing the underlined letter.

Dialog box options
A dialog box can contain the following options:
Command buttons
A command button initiates an action, such as carrying out or canceling a
command. The OK, Cancel and Help buttons are common command buttons. They
are often located along the right side of a dialog box.
The currently selected button has a border that is darker than that of other buttons.
Unavailable options appear dimmed.
Example of a command button:

To choose a command button:
n
click the desired command button with the mouse, or
n
press Tab until the button you want is selected, then press Enter.
Text boxes
In a text box you type information. When you move to an empty text box, an
insertion point (a flashing vertical bar) appears. The text you type starts at the
insertion point.
ILWIS Reference Guide
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If the box you move to contains text, and the text is highlighted, any text you type
will replace it. You can also delete existing text by pressing the Del or Backspace.
Example of a text box:

To select text in a text box:
n
drag the pointer across the text, or double-click a word to select one word at a
time, or
n
position the mouse pointer in the text box and press and hold down Shift while
pressing an arrow key.
List boxes
A list box displays a list of choices. If there are more choices than can fit in the
box, scroll bars are provided so you can move quickly through the list.
Usually, you can select one item in a list box.
Example of a list box:

To select an item with the mouse:
n
click the up or down scroll arrow, or drag the scroll box until the item you want
to select is displayed,
n
click the item.
To select an item by using the keyboard:
n
press the Up Arrow or Down Arrow key to move through the available options
until you reach the one you want.
Drop-down list boxes
A drop-down list box initially appears as a rectangular box containing the current
selection. When you select the down arrow in the square box at the right, a list of
available choices appears. If there are more items than can fit in the box, scroll bars
are provided. In ILWIS, you will sometimes find at the right end of a drop-down
list box, a so-called create button. When you click on the create button, an object
can be created.
Examples of a drop-down list box:
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To open a drop-down list box and select an item with the mouse:
n
click the box or the arrow to open the list box,
n
click the up or down scroll arrow, or drag the scroll box until the item you want
to select is displayed,
n
click the item.
To select an item from a drop-down list box by using the keyboard:
n
press the Up Arrow or Down Arrow key to move through the available options
until you reach the one you want.
To create an object with the create button:
n
click the create button (rising sun) at the extreme right of the list box.
Option buttons
Option buttons represent a group of mutually exclusive options. You can select only
one button at a time. If you already have one option selected, your current selection
replaces it. The selected option button contains a black dot. Names of unavailable
options appear dimmed.
Example of option buttons:

To select an option button:
n
click the option button or press the Spacebar.
If the option has an underlined letter, you can select the option button by pressing
and holding down Alt while typing the underlined letter.
Check boxes
A check box presents non-exclusive options: you can select as many check box
options as needed. When a check box is selected, it contains an X. Names of
unavailable options appear dimmed.
Example of a check box:
To select or clear a check box:
n
click the check box with the mouse, or press the Spacebar.
If the option name has an underlined letter, you can select or clear the check box by
pressing and holding down ALT while typing the underlined letter.
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1.3 Getting started with ILWIS for Windows
When the ILWIS icon is double-clicked in Windows Program Manager, the ILWIS
logo appears, followed by the ILWIS Main window.

Main window
Just below the menu bar you see a line in which text appears as soon as you click a
map or menu command. This is the command line, on which you can type for
example MapCalc statements. Below the command line is a button bar which
allows you to quickly display maps or tables. If you want to change to another
directory or drive you can use the navigator: the list boxes to the right of the button
bar.
The central right part of the Main window is the Catalog. It
displays the ILWIS objects in the current directory. All ILWIS
objects are preceded by an icon. The icons preceding data
objects are:
for map lists,
for raster maps,
for polygon maps,
for segment maps,
for point maps,
for tables.
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To see more objects in the Catalog than only data objects, see How to customize the
Catalog. For a list of all ILWIS objects and their icons, see ILWIS objects. For short
Help on an object in the Catalog, click an object with the right mouse button and
choose Help from the context-sensitive menu.
Below the Catalog, you find a scroll bar which you can use to view more objects of
the current directory in the Catalog.
The left part of the Main window is the Operation-list. It contains all ILWIS
operations preceded by an icon. To the right of the Operation-list, you find a scroll
bar which you can use to view more operations.
At the bottom of the Main window you see the status line which gives additional
information on maps, tables, operations, etc. The Main window can be sized by
dragging its borders.
Displaying maps and tables
There are several ways to open a map or table in a window:
n
open the File Menu, choose the Open command, and select a map or table to
display, or
n
double-click a map or table in the Catalog.
Other ways to display maps and tables are by using the button bar, the contextsensitive menu under the right mouse button when the mouse pointer is positioned
on a map or table, or by double-clicking the Show item in the Operation-list. When
opening a map, a dialog box appears in which you can specify some display options
for the map.
A map is displayed in a map window. You can open as many map windows as you
like. A map window can display one raster map, one or more vector maps, or one
raster map with one or more point, segment, and polygon maps and annotation.
You can zoom in and out, and if the map does not fit in the map window, you can
scroll. You can add other maps to an existing map window, either by dragging the
desired map from the Catalog to the existing map window, or by using the Add
Data Layer command on the Layers menu of the Map window. To see the value or
meaning of a pixel, point, segment, or polygon of displayed maps in a map window,
you can press the left mouse button (info). When the displayed map has an attribute
table, you can double-click in the map window to see and edit the attributes. To add
or to remove layers from a map window, or to change display options of a layer,
you can use Layer Management command on the Layers menu. Multiple map and
annotation layers displayed in a map window can be saved as a map view.
A table is displayed in a table window. You can open as many table windows as you
like. Each table window displays one table. A table can be shown as a whole, or
record by record. When the table does not fit in the table window, you can scroll.
Fields in a table can be edited by clicking them. The width of a column and the
order of columns can easily be changed. From a table window, you can create
graphs in a graph window.
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Pixel info
In the pixel information window you can get information on multiple maps and
attribute tables which contain attribute data. Open the pixel information window
through the command Open Pixel Info on the File menu of the Main or a map
window. Add one or more maps to the pixel info window by using the File menu of
the pixel info window, or drag map icons from the Catalog to the pixel information
window.
Starting ILWIS operations
ILWIS operations, such as Distance calculation or Filter, are listed in the
Operation-list. There are four ways to start an ILWIS operation:
1. Open the Operations menu in the Main Window and choose an operation , or
2. Double-click an operation in the Operation-list, or
3. Press the right mouse button on an object in the Catalog: a context-sensitive
menu appears from which you can choose an operation, or
4. Drag an ILWIS data object from the Catalog to an operation in the Operationlist.
Usually a dialog box is opened in which you can select input and output object
names and where you can set some parameters necessary for the operation. To
obtain short Help on an operation in the Operation-list, click an operation with the
right mouse button and choose Help from the context-sensitive menu.
Command lines
Map calculation formulae can be typed on the command line of the Main window,
table calculation formulae can be typed on the command line of a table window.
These command lines can also be used as a pocket line calculator. The command
line of the Main window can also be used to type ILWIS commands, ILWIS
expressions, or to run a script.
Advanced users might want to know the new functions and capabilities of ILWIS
2.1 compared to the previous version. They can start to import ILWIS 1.3 and 1.4
data.

1.4 Importing data from ILWIS 1.4
Data from ILWIS 1.3, 1.4 or 1.41 can be imported into ILWIS 2.1 for Windows.
Below, you find some preparative hints to make Import 1.4 and later ILWIS 2.1 run
smoothly. In the remainder ILWIS 1.4 is used meaning ILWIS 1.3, 1.4 or 1.41.
1. First of all, make a backup of your existing data.
2. Organize the data to be imported in one or more directories. By default, Import
1.4 is running on a whole directory. You can specify a mask to select the objects
to be imported.
It is strongly advised to take the following paragraphs into account before starting
to import 1.4.
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Importing satellite images
The .MPD and .MPI files of the satellite bands should be available. Any .HSB or
.COL files can be deleted. During Import 1.4, select domain Image for satellite
imagery.
Importing color composites
The .MPD, .MPI, and .COL files of the color composite should be available. You
may need to save the color composite's color look up table (.COL) in ILWIS 1.4;
give it the same name as the color composite. During Import 1.4, select domain
Picture for color composites.
Importing raster maps created from vector data, and attribute tables
For the raster data, vector data and attribute tables, select during Import 1.4:
n
domain Class when the elements in the original polygon, segment or point map
are named by class names (e.g. mapping units in thematic maps). The classes
may occur in various parts in the original polygon, segment or point map. The
.MPD, .MPI, .COL and .INF files should be available for domain Class raster
maps.
n
domain ID, when the elements in the original polygon, segment or point map
are uniquely named (e.g. cadastral plots). The .MPD, .MPI, and .INF files
should be available for domain ID raster maps.
n
domain Value when the elements in the original polygon, segment or point map
refer to measurable values (e.g. contour lines). The .MPD and .MPI files should
be available for domain Value raster maps.
When importing polygon maps that were rasterized, the .SEG, .CRD, .TOP and
.POL files should be available. All these files should have the same name: e.g.
LANDFORM.SEG, LANDFORM.CRD, LANDFORM.TOP, LANDFORM.POL. If
this is not the case:
n
create a label point file for the polygon map (SegPol),
n
use CopySeg to copy those segments of which one polygon map should be
created,
n
re-polygonize (SegPol),
n
assign labels to the polygons (SegPol).
When importing segment maps that were rasterized, the .SEG and .CRD files
should be available. When importing point maps: the .PNT should be available.
There is no need for .SLG, .PLG, .SGC or .PLC files.
Import of attribute tables works best when attribute tables have the same names as
the maps to which they relate. Attribute tables are expected to have the extension
.TBL. In case you have your attributes in an .INF or .PNT table, it is advised to
save these as .TBL as well. Attribute tables are expected to have a Name$ column.
Attribute table can only be linked to domain Class or domain ID maps, not to
domain Value maps.
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Make sure that you select the same domain names for the vector data during import
as for the rasterized forms of these maps. Also, select the same domain names for
the attribute tables as for the maps to which they relate.
In ILWIS 2.1, polygonized segment maps are only imported as polygon maps. This
is correct: display of polygon boundaries over a raster map in ILWIS 2.1 has the
same effect as displaying segments over a raster map in ILWIS 1.4.
Importing maps obtained through calculations: For maps containing measurable
values, for example created by MCalc calculations or by interpolations, the .MPD
and .MPI files should be available. Any .HSB, .HSI files can be deleted. During
Import 1.4, select domain Value. If you have a byte map with a user-defined color
lut, see the next paragraph.
Importing maps obtained through calculations
For maps containing measurable values, for example created by MCalc calculations
or by interpolations, the .MPD and .MPI files should be available. Any .HSB, .HSI
files can be deleted. During Import 1.4, select domain Value. If you have a byte
map with a user-defined color lut, see the next paragraph.
Importing classified raster data
Byte maps containing classes are expected to have an .INF table with the class
names and a color lut .COL. Such maps may for instance be obtained by a classify
operation in MCalc using a classify table, or are output maps of an image
classification. However, maps created through a classify table do not yet have an
.INF table; it is advised to create one before Import 1.4. You could do this in ILWIS
1.4 TabCalc: create a table with as many records as classes in your map, add one
column Name$, and type the meanings of your classes for each record, save as
.INF. Of course, the same can be obtained with an editor.
As mentioned before, Import 1.4 works smoothly when the .MPD, .MPI, .COL and
.INF files are available. It is also advised that the files have the same file name, e.g.
DISTCLAS.MPD, DISTCLAS.MPI, DISTCLAS.COL, and DISTCLAS.INF.
During Import 1.4, select domain Class.
Mind: if you do not make the effort to create an .INF table beforehand, then select
domain Class or ID during Import 1.4, and edit this domain later yourself.
Importing other raster data
To import bit maps, the .MPD and .MPI files should be available. There is no need
for a .COL file. Bit maps are automatically imported with domain Bit.Scanned
raster data can be imported when the .MPD, .MPI are available. If the scanned data
consists of gray values, select domain Image during Import 1.4. If the scanned data
is in color, the .COL should also be available. Select domain Picture during Import
1.4.
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Import of point tables
For point tables with a Name$ column, you can follow the instructions in paragraph
'Importing raster maps created from vector data, and attribute tables'; select domain
Class or domain ID. Point tables without a Name$ column are imported as a
domain ID map.
Importing vector data without raster data
Vector data will rarely occur without raster data. You can follow the instructions in
paragraph 'Importing raster maps created from vector data, and attribute tables'.
Importing other tables
Tables without a Name$ column (.TBL or other extension) can be imported by
selecting domain None during Import 1.4. At the moment, Import 1.4 has no
facilities to import classify tables (.CLT) or 2-dimensional tables (.TB2).
Histograms from ILWIS 1.4 (.HSB, .HSI) can be deleted; they are recalculated in
ILWIS 2.1.
Batch files
Import of existing batch files is not possible.
To start importing maps and tables from version 1.4
Choose the Import from version 1.4 command on the File menu of the Main
window or double-click the Import 1.4 item in the Operation-list.
n
Indicate for each object to be imported the domain type. When selecting domain
Class or ID, enter a name for the domain object or accept the default domain
name. The domain contains the valid class names or IDs in one or more maps.
n
For raster maps, Import assigns the same georeference to all maps of the same
area. When a georeference name is asked, enter a name indicating the area.
n
Give a description for each file that you import. The descriptions appear in the
title bar when the imported objects are displayed.
Import of maps and tables with more than 256 classes or IDs may take quite some
time. When Import has finished you can start to display your maps, etc., see Help
topic Getting started with ILWIS 2.1.

ILWIS Reference Guide

15

Chapter 2

.

Basic concepts
2.1 ILWIS window types
Basically, there are four ILWIS window types: the Main window, map windows,
table windows, pixel info windows.
The Main window is the window which is opened when ILWIS is started. The Main
window consists of:
n
a Command line on which you can type commands to display objects, map
calculation formulae, expressions to perform complete operations, run scripts,
etc.;
n
a Catalog, which gives an overview of available objects in the current directory;
you can for instance drag a map from the Catalog to an existing map window,
or to an operation in the Operation-list;
n
an Operation-list, and the Operations menu which list all ILWIS operations;
and
n
a navigator to go to other drives or directories.
A map window : one or more maps with optional annotation. You can open as
many map windows as you like. When a raster map is displayed, you can display
other point, segment or polygon maps on top of this raster map; add annotation;
zoom in and out; and scroll through the map if the map does not fit in the map
window. To add or remove layers, or to change display options of a layer, use the
Layer Management command on the Layers menu. To see the value or meaning of
a pixel, point, segment, or polygon displayed in a map window, press the left mouse
button (info). When the displayed map has an attribute table, you can double-click
in the map window to see and edit the attributes. You can use the map editors to
edit positions, values or meanings of points, segments, polygons and pixels. A map
window displaying one or more maps with optional annotation can be saved as a
map view. Map views that consist of a time series can be displayed as a slide show.
A table window : a table and allows you to edit the table. You can open as many
table windows as you like. A table can be shown as a whole, or record by record.
When the table does not fit in the table window, scroll bars are provided. Fields in a
table can be edited by clicking them. The width of a column and the order of
columns can easily be changed. On the command line in a table window, you can
enter table calculation statements. Besides table calculations, you can perform joins
between tables, aggregations and a least squares fit. From a table window, you can
create graphs in a graph window.
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Further a table window displays histograms; you can calculate with the columns of
the histogram. Also point maps, class/ID/picture domains and class representations
can be opened as a table; you can perform special calculation with the coordinates,
colors, etc.
In the pixel info window, you can see the values or meanings of multiple maps and
attribute values stored the attribute tables of the maps at the current position of the
mouse pointer in a map window.
Map windows, table windows and the pixel information window are called data
windows because they can display data objects.

2.2 ILWIS objects and icons
There are several types of ILWIS objects: data objects, service objects, special
objects and annotation.
Data objects are point, segment, polygon and raster maps, satellite images, tables
and columns; that are the GIS/RS materials to work with. Maps can be displayed
and edited in a map window, tables and columns in a table window. You can
perform calculations and operations on data objects.
Data objects are:
raster maps
polygon maps
segment maps
point maps
map lists
tables
columns

(containing pixels)
(containing area features)
(containing line features)
(containing point features)
(containing a set of raster maps)
(containing columns)
(not listed in Catalog)

Service objects are domains, representations, georeferences, and coordinate
systems. Service objects are used by data objects; they contain accessories that data
objects need besides the data itself. Service objects can be selected to serve one or
more data objects; they can be created, edited, etc. through the properties of an
object.
Service objects are:
domains
representations
georeferences
coordinate systems
Special objects are map views, histograms, sample sets, two-dimensional tables,
matrices, filters, user-defined functions and scripts.
Special objects are:
map views
histograms of raster maps
histograms of polygon maps
histograms of segment maps
18
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histograms of point maps
sample sets
two-dimensional tables
matrices
filters
functions
scripts
Annotation can be added as one or more annotation layers to a map window: text,
legend, boxes, scale bar, North arrow, grid lines, graticule, and bitmaps or pictures
from disk. Pictures and bitmaps can also be pasted into ILWIS from other Windows
application programs (via the clipboard). Annotation can be displayed in a map
window in combination with maps: this can be saved as a map view.
For more information, refer to chapter 4 ILWIS objects, to Appendix B.1 ILWIS
objects or to Appendix B.2 Relations between ILWIS objects.

2.3 Before creating ILWIS maps and tables
A map contains certain features and refers to the geographic position of those
features:
point maps: a point map contains point features;
segment maps: a segment map contains line features;
polygon maps: a polygon map contains closed area features, and
raster maps: a raster map contains pixels. In ILWIS, most spatial operations
are performed on raster maps.
When using satellite images, you already have raster maps. Pixels in a satellite
image have values ranging from 0 to 255, although not every value may occur in
your image. In ILWIS, satellite images have domain Image.
When starting from an analog paper map, you begin with:
n
digitizing point features of interest with the point editor,
n
digitizing line features of interest with the segment editor, and/or
n
digitizing areas of interest with the segment editor and polygonize.
n
digitizing the boundaries of area features of interest with the segment editor;
then polygonizing these boundaries to obtain polygons; and editing the polygons
with the polygon editor.
Afterwards, point, segment and polygon maps can be rasterized into a raster map.
However, before digitizing, you have to know that features in any map can be
identified in the following manner:
n
by ID:
each feature is identified by its own name or number and
occurs only once in the map,
n
by Classes:
features are identified by their class name and may occur in
several places in the map,
n
by Value:
features are identified by a measured, calculated or
interpolated value.
ILWIS Reference Guide
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The following scheme illustrates the above:
Map type:

Features in map:

Point map

∗
∗
∗
∗
∗
∗
∗
∗
∗

Segment
map
Polygon map

Raster map

Raster map

Points: indiv. sample points
Points: classes of farms
Points: height information
Lines: individual rivers
Lines: classes of roads
Lines: isolines for height
Areas: indiv. cadastral plots
Areas: land use classes
Areas: acid deposition

∗ Pixels: rasterized points,
lines or areas with IDs
∗ Pixels: rasterized points,
lines, or areas with class
names
∗ Pixels: rasterized points,
lines or areas with Values
∗ Pixels: value outcome of
calculations
∗ Pixels (satellite images)

Identification
of features
by:
IDs
Class names
Values
IDs
Class names
Values
IDs
Class names
Values

Example:

Class names

1,2,3
small farm, large farm
500, 600, 700 (m)
rivsect1, rivsect2
prim. roads, sec. roads
500, 600, 700 (m)
plot 234a, plot 345b
rice, maize, forest
1000, 2000, 5000
(mol/ha/y)
plot 234a, plot 345b or
rivsect1, rivsect2
rice, maize, forest

Values

values

Values

any value

pixel values:
0 to 255

-

IDs

The user-defined collection or set of IDs, class names or values that may be used in
a map is called the domain of a map. In ILWIS, we speak of maps with domains of
the ID, class or value type, meaning that the elements in that map are either
identified by IDs, class names or values.
Only maps with features identified by IDs or class names can have attributes; i.e.
extra information about the point, segment, polygons or mapping units, in so-called
attribute tables. When creating an attribute table, this table should have the same
domain as your ID or class map. Afterwards you can add extra columns with the
attribute information. The domain provides here the relational link between the
map and the attribute table.
Maps containing values, for example a satellite image or a height map, cannot have
attributes in an attribute table.

2.4 Working with domains
A domain defines the values, classes or identifiers that can be stored in a map or
column. When you create a map or column, you also have to select or create a
suitable domain for that map or column. When you create an attribute table for a
map, the table must use the same domain as the map to which the table refers; the
domain provides the link between the map and the table. Further, a domain uses a
certain representation which defines the graphical representation of a map, e.g. the
coloring.
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All ILWIS data objects have a domain. One domain can be used for several data
objects. To view the domain of a data object, open the properties of that data object.
To list existing domains in the Catalog, refer to How to customize the Catalog.
The four main types of domains are:
ID
for data objects that contain unique identifiers (e.g. plot 1024, plot
1025)
n Class
for data objects that contain classes (e.g. soil units: clay, sandy loam)
n Value
for data objects that contain measurable values (e.g. height,
concentration)
n Image
for satellite images and scanned aerial photographs that contain values
between 0 and 255.
n

Domains for new maps
When you create a new map, you should also select or create a suitable domain for
the map. As described above, you can:
n create a class domain Soils when you want to digitize soil classes and fill this
domain with your soil classes;
n create an identifier domain Plots when you want to digitize unique identified
cadastral plots and;
n create a value domain Height when you want to digitize contour lines.
You can directly add classes to a class domain when you create the domain, but you
can also add classes to the domain when actually editing or digitizing the map.
Identifier domains can automatically be filled with numbers, but you can also add
the identifiers yourself.
However, when working for instance with multiple land use maps of different
years, the idea is that you create only one class domain Landuse in which you enter
all possible land use classes of all years. This domain can then be used for all your
land use maps and related attribute tables. It is not necessary that all classes in the
domain actually occur in each map. As a domain is linked to a representation, the
use of one domain for maps of the same theme ensures that these maps are also by
default displayed in the same colors.
Domains for attribute tables and columns
For maps using a class or ID domain, you can create an attribute table. You have to
make sure that the table uses the same domain as the map because the domain
provides the link between them. In the table, the class names or IDs of the domain
appear on the record buttons. You can add attribute columns to the table which
contain additional information on the classes or IDs in the map. When you create
columns in the attribute table, you may create suitable domains for each column;
for general use of values however use the system domain Value.
Domains for value maps and value columns
When calculating with value maps and value columns, you can usually accept the
default system domain Value and adjust the value range and precision for the
output map if necessary. You only need to create a user-defined value domain (e.g.
Height, pH, Yields, or concentration values):
ILWIS Reference Guide
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n

n

if the output values have a specific 'standardized' meaning that you want to
document, and
if you have, or want to create, a specific representation for these values (colors
are linked to values).

A number of value domains are available in your ILWIS\SYSTEM directory:
Value, Count, Distance, Min1to1, NOAA, Perc, Radar. For calculations on value
maps, you can of course also use the Image domain.
Other domain types
n
Bit
system domain Bit is available for maps and columns that have to store
values 0 and 1.
n
Bool system domain Bool and system domain Yes/No are available for
maps and columns that have to store True, False or undefined
values.
n
Picture for raster maps which contain merely colors, the pixels have no
meaning, for instance color composites or scanned pictures.
n
Color for raster maps that are stored in 24-bit colors.
n
Group a user-defined list of values and class names that can be used to
classify a value map (similar to the ILWIS 1.41 classify tables)
n
String system domain String is available for columns that contain text.

2.5 Attribute tables
Attribute tables store additional information on elements in a map, i.e. extra tabular
data which relates to the mapping units, points, segments, or polygons in your
maps.
Raster, polygon, segment and point maps that use a domain of the class or ID type
can have attribute tables. The domain of the attribute table should be the same as
the domain of the map to which it relates. The domain is the relational link
between the map and the attribute table.
Maps of domain type Value contain purely values; they cannot have attributes.
When a map that is linked to an attribute table is displayed in a map window, and
you double-click in the map, the attributes of the selected class or ID are shown and
can be edited. Whether an attribute table is linked to a map can be inspected in the
properties dialog box of the map.
The best way to create an attribute table is:
n
open the properties of a point, segment, polygon or raster map,
n
in the Properties dialog box, select the Attribute check box, and
n
create a new table by clicking the create button or select an existing table (only
tables with the same domain as the map are shown).
For more information, refer to How to view and edit the properties of an object and
How to create a table.
You can perform calculations on your attribute data in the attribute table with Table
Calculation, and you can also derive another map from a column in an attribute
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table with the Attribute Map, Attribute Polygon Map, Attribute Segment Map or
Attribute Point Map operations.
Example
A map with terrain units may have the following classes: Lagoon plain, Coastal
upland, Infilled valleys, Inland levees, Volcanic hills moderately steep, Volcanic
hills steep, Colluvial footslopes, etc. Attributes for these classes might be: minimum
and maximum slope, slope length, drainage density, genesis, etc.

2.6 Layers in a map window
When displaying multiple maps and/or annotation in a map window, two types of
layers are distinguished: data layers and annotation layers.
Data layers are the different maps (data objects) displayed in one map window. For
each map displayed in the map window, display options have to be specified, such
as colors, width of segments, etc.
Annotation layers are the different annotation types displayed in one map window.
For each annotation object displayed in the map window, display options have to be
specified.
All layers (incl. display options) of a map window can be saved as a map view.
Layers of the current map window are listed:
n
on the Layers menu, select the Display Options command: a cascading menu
appears with the layers,
n
on the Layers menu, select the Layer Management command: a dialog box
appears with a list box of the layers in the map window,
n
on the context-sensitive menu which appears when you click the right mouse
button in a map window.
On the cascading and context-sensitive menus, shown layers are marked by a
checkmark (√). To change the display options of a layer, select a layer on one of
these menus or in the Layer Management dialog box by double-clicking it.

2.7 Map views
When a set of data and annotation layers is displayed in a map window, you may
store such a set as a map view. A map view contains the names of data layers
and/or annotation layers to be displayed in one map window. Also, the display
settings of the layers are stored; so the system knows the colors, widths etc. for the
display of each layer. Further, the georeference is stored, meaning that when you
save a map view when zoomed in on a part of the map, this zoomed area will be
displayed when opening the map view later.
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By opening a map view later, the map window appears exactly as it was saved. You
do not need to select any data or annotation objects, nor specify their display
options.

2.8 Drag and drop
The idea of drag and drop is that you can pick up an ILWIS object from the Catalog
and release it somewhere else, in order to perform a certain task without using any
menu.
The drag and drop mechanism can for example be used:
n
to add maps or annotation objects to an existing map window,
n
to add maps with their attribute table to the pixel information window,
n
to start an operation with a certain map or table,
n
to avoid typing any input object names in an operation dialog box.
In a table window, drag and drop is used to change the width and sequence of
columns.
How to drag and drop
1. Select an ILWIS data object from the Catalog by pressing and holding the
left mouse button down, and
2. while holding the left mouse button down, move the mouse:
- to a map window,
- to the pixel information window,
- to an operation in the Operation-list, or
- to a drop-down list box in a dialog box (drag),
3. then release the left mouse button (drop).
When to drag and drop
The drag and drop mechanism can be used in ILWIS:
n
to add extra maps to an existing map window: drag a point, segment, or
polygon map from the Catalog to the map window,
n
to add maps and their attribute data to the pixel information window: drag a
map from the Catalog to the pixel info window,
n
to start an ILWIS operation with a certain map or table: drag a map or table
from the Catalog to an operation in the Operation-list. The dialog box of the
operation will appear, the input map or table is already filled in,
n
to use a certain map or table name as input for an operation: drag the map, table
or any other object to a drop-down list box on a dialog box,
n
in a table window: change the order of columns by dragging a gray column
name to another position; change the width of a column by positioning the
mouse in between two column names (the mouse pointer changes into a doublesided arrow), and drag to the left or right. This decreases or increases the width
of the left column.
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2.9 Dependent data objects
Dependent maps, tables and columns are the result of a calculation with MapCalc
or TabCalc (in which you used the definition sign =) or the result of another
operation. The complete expression by which dependent output objects are created
is stored by the output maps, tables and columns as their definition. Dependent data
objects thus know how they were created and on which input data they depend.
Example
You digitized roads as segments, you rasterized the segment map and then
performed the Distance operation: you obtain a raster map with distances to the
nearest road. Both the rasterized segment map and the output map of the Distance
operation are dependent maps. When you edit the segment map later and added for
instance new roads, it is obvious that both the rasterized segment map and the
output distance map need to be updated according to the new situation, i.e. the
dependent maps need to be recalculated.
Advantages of working with dependent data objects
Easy update: when you have new information and you accordingly edited input
maps, tables or columns, the dependent output maps, tables or columns can be
recalculated as the system can execute their definition again. There is thus no need
to repeat operations and choose input and output objects again: you can simply
press the Make Up-to-Date button in the Properties dialog box of the dependent
output maps, tables or columns.
Easy change of calculation formulas: MapCalculate and ColumnCalculate
formulas that are stored as the definition of dependent raster maps and columns can
be modified in the Properties dialog box of such a map or column. This enables you
to quickly change calculation formulas and see results displayed in the same raster
map or column. The need to create new maps and columns for each similar
calculation is thus reduced. To edit the MapCalc formula by which a dependent
raster map is created: press the Edit Definition button in the Properties dialog box
of the raster map. The TabCalc formula of a dependent column can directly be
edited in the Properties dialog box of the column.
Minimum use of disk space: when you perform a calculation or another operation,
the outcome is a dependent map or table and in principle only the object definition
file of the dependent map (.MPR, .MPA, .MPS, .MPP) or table (.TBT) is stored on
disk. Object definition files are small ASCII files and they store amongst others the
expression by which the output object is created and contain a reference to the
output data file(s). You can directly continue to perform calculations and/or
operations on the dependent objects that do not have calculated data files yet. The
data files which may need a lot of disk space are automatically calculated and
stored on disk when the map or table is displayed, i.e. when needed. In most cases,
also the pixel information window can even show results of dependent raster maps
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that do not have calculated data files yet. The pixel information is able to calculate
output values of pixels on the fly.
For dependent maps and tables that already have stored data files, you can delete
the data files that are not needed immediately. As long as the object definition file
of a dependent object remains, the data files can always be recalculated. To release
disk space: press the Release Disk Space button in the Properties dialog box of a
dependent map or table.
To protect the results of calculations or operations, you cannot directly edit
dependent maps, columns in dependent tables, or dependent columns. In case you
do want to edit a dependent map or column, you first have to break the dependency
link between the dependent map or column and its input data. To break
dependencies: press the Break Dependency Link button in the Properties dialog box
of dependent maps or dependent columns.

2.10 Properties of objects
The Properties dialog box of a map, table or column or any other ILWIS object
shows you important information on the object. In fact, an object's Properties dialog
box lists the information that is stored in an object's object definition file and that is
relevant to the user.
A Properties dialog box lists:
n
object type, object name and its date, time and size,
n
whether the object is read-only or not,
n
the description of the object,
n
other objects that this object uses, e.g. the domain of a map, table or column; the
georeference of a raster map; the coordinate system of a point, segment or
polygon map, etc., see also Appendices : relations between ILWIS objects;
n
objects that use the current object,
n
for maps and domains, whether an attribute table is linked to the map or the
domain,
n
some additional information on the object, e.g. the number of segments in a
segment map, and the number of lines and columns and the pixel size in a
raster map, and the number of records and columns in a table, etc.,
n
whether a map, table or column is dependent or not, see also Basic concepts :
dependent data objects;
n
for dependent maps, tables and columns, the definition of the object, i.e. the
expression by which the current object was created,
n
for dependent maps, tables and columns, whether the object is up-to-date or not,
n
for dependent maps, tables and columns, the objects on which the dependent
object depends,
n
for raster maps, whether the map is stored using 1 bit, or 1, 2, 4, or 8 bytes per
pixel.

26

ILWIS Reference Guide

ILWIS Basic concepts
Further, a number of the following buttons may be available:
Used By:
Click this button to see by which other objects the
current object is used.
Make Up-to-date:
For dependent data objects of which the input data
has changed: click this button to redefine the
dependent output object. See also How to make
dependent data objects up-to-date.
Edit Definition:
For dependent raster maps that are the result of a
map calculation (MapCalculate), click this button to
modify the map calculation formula by which this
map was created. The definition of a dependent
column that is the result of a table calculation
(ColumnCalculate), can be directly edited in the
Properties dialog box of the column. See also How
to change the definition of a dependent data object.
Break Dependency Link:
For dependent data objects: click this button to
break the dependency links between the current
dependent object and the objects it depends on.
After breaking dependency links of a dependent
map, table or column, the map, table, or column
becomes editable. See also How to break
dependency links.
Release Disk Space:
For dependent data objects with a calculated data
file: click this button to delete calculated data files.
Only the object definition file that contains the
expression by which the object is defined remains.
See also How to release disk space.
Calculate:
For dependent data objects without a calculated data
file: click this button to execute the expression by
which this object was created and store the
calculated data file on disk.
Additional Info:
For objects that have extra information.
Edit Properties:
For advanced users: click this button to see and/or
change the relations between the current editable
object and other objects that the current object uses,
such as domain, georeference, coordinate system,
etc.
For more information, refer to section 8.38 How to view and edit properties of an
object, or Appendix Relations between ILWIS objects.
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Chapter 3

.

ILWIS window types
and their functionality
3.1 Main window
3.1.1 Introduction
The picture below shows the ILWIS Main window.

The Main window contains:
n
Menu bar: the Main window has five menus: File, Edit, Operations, Options,
and Help.
n
Command line: the command line is found just below the menu bar. Advanced
users can type commands and expressions on the command line to perform map
calculations, operations, and series of calculations and/or operations described
in user-written scripts.
n
Button bar: located just below the command line. The button bar provides short
cuts for some regularly used menu commands.
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n

n

n

n
n

n

n

n

The navigator is found to the right of the button bar. Use the navigator to select
another drive or subdirectory.
Catalog: the central part of the Main window is called the Catalog. It provides
an overview of available ILWIS objects in the current directory.
Data objects in the Catalog can be double-clicked, and can be dragged to an
existing map window, to the pixel information window, to an operation in the
Operation-list, or to a text or list box in a dialog box. By using the right mouse
button on a data object in the Catalog a context-sensitive menu appears which
contains all relevant operations for that object.
Service objects and special objects can be double-clicked to display or edit them.
The horizontal scroll bar below the Catalog allows you to view more objects of
the current directory in the Catalog.
Operation-list: located along the left side of the Main window. The Operationlist provides an overview of ILWIS operations. Operations are preceded by an
icon of the output object of that operation. You can start an operation by doubleclicking an operation in the Operation-list, or by dragging an ILWIS object
from the Catalog to the operation in the Operation-list to start the operation
with that object. Of course, you can also start operations by selecting one from
the Operations menu.
The vertical scroll bar to the right of the Operation-list allows you to view more
operations in the Operation-list.
Status line: located at the bottom of the Main window. The status line gives
short explanations on highlighted menu commands, functionality of buttons in
the button bar, the description of objects in the Catalog, and a short description
of the operations in the Operation-list.

The Main window can be sized by dragging its borders. For information on
minimizing, maximizing the Main window, using scroll bars, using menus, etc.,
see the Introduction on Windows features topic.

3.1.2 Catalog
The Catalog is located at the central part of the Main window. The Catalog
provides an overview of ILWIS objects in the current directory.
By default, the Catalog lists available data objects in the current directory; these are
preceded by the following icons:
for map lists
for raster maps
for polygon maps
for segment maps
for point maps
for map views
for tables
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If you want to see more or other objects in the Catalog, refer to How to customize
the Catalog. For short help on objects in the Catalog, click an object with the right
mouse button and choose Help from the context-sensitive menu.
The Catalog is sensitive to clicking, double-clicking and drag and drop actions.
You can for instance use the Catalog to display a map or table or to start an
operation with a certain map or table. Using the Catalog capabilities is far more
efficient than using menus. For more information, see How to use the Catalog.
In general, it can be mentioned that:
n
when moving the mouse pointer over an object in the Catalog, the status line
displays the description of that
n
double-clicking an object in the Catalog opens that object in a new window,
n
clicking the right mouse button on an object in the Catalog makes a contextsensitive menu appear from which you can choose a command or an operation,
n
dragging a raster, polygon, segment or point map to an existing map window or
to the pixel info window, adds that object to that window,
n
dragging a data object from the Catalog to an operation in the Operation-list,
opens the dialog box for that operation with the input map (or table) name
already selected,
n
when a dialog box is opened and it contains a drop-down list box, you can drag
an object from the Catalog to this list box instead of selecting the desired object
from the list box.
For more information, refer to section 8.36.1 How to use the Catalog and section
8.11.1 How to customize the Catalog

3.1.3 Operation-list
The Operation-list is located along the left side of the Main Window. The
Operation-list provides an overview of ILWIS operations. Each operation is
preceded by an icon; the icon indicates the output data type of the operation.
Furthermore, the Operation-list contains New commands to create new objects,
Show and Edit commands, to show/open or edit an object and Pixel Info command
to open the pixel information window.
For more information on available operations in the Operation-list, see the help on
ILWIS Operations. For short Help on operations in the Operation-list, click an
operation with the right mouse button and choose Help from the context-sensitive
menu.
Just like the Catalog, the Operation-list is very sensitive to clicking, double-clicking
and drag and drop actions. The Operation-list is mostly used to start operations
bypassing the Operation menu, or to create, show or edit objects. Using the
Operation-list capabilities is far more efficient than using menus. For more
information, see Help topic How to use the Operation-list.
In general, it can be mentioned that:
n
when moving with the mouse pointer over an operation, the status line displays
a brief description of that operation,
n
double-clicking an operation starts that operation,
ILWIS Reference Guide

31

ILWIS window types
n

n

dragging a data object from the Catalog to an operation in the Operation-list,
opens the dialog box for that operation and the input map (or table) name is
already selected,
when clicking an operation with the right mouse button, a little contextsensitive menu appears; you can start the operation or obtain short Help on this
operation.

For more information, refer to section 8.36.6 How to use the Operation-list or to
chapter 7 ILWIS operations.

3.1.4 Main window Command line
The command line of the Main window is located at the top of the Main window,
just below the menu bar. A picture of the Main window is presented in Help topic
Main window: introduction. The user may type commands and expressions on the
command line to carry out calculations, operations and scripts.
The command line is used:
n
to perform calculations with maps and attribute tables,
n
to perform ILWIS commands: to display, edit, create or view the properties of
ILWIS objects, and to obtain dialog boxes to start an ILWIS operation. This
functionality is equivalent to typing an ILWIS 1.4 executable name on the DOS
command line in ILWIS version 1.4.
n
to perform ILWIS expressions: to perform complete ILWIS operations. This
functionality is equivalent to typing the ILWIS 1.4 executable name and all
parameters required by this executable, on the DOS command line in ILWIS
version 1.4.
n
to run scripts, which usually contain a sequence of ILWIS expressions. With a
script, you can build a complete GIS and Remote Sensing analysis/application
for your own research discipline. Scripts are more or less equivalent to batch
files in ILWIS version 1.4.
n
to copy and delete objects, break dependency links of objects, etc. For more
information, see ILWIS commands and ILWIS script syntax.
F

The command line has a history: use the Arrow-Up key to retrieve previously used
expressions and commands. The Arrow-Down key can be used to scroll forwards
again.
Other functionality:
?expression
Performs calculations as a pocket line calculator,
!Applic
Acts as the Windows Run command to start any Windows
application program, batch file, or DOS application (with a .PIF
file available). Applications that can be started from the command
line may have the following extensions: .exe, .com, .bat, .pif.
Type the application name directly after the exclamation mark (no
spaces allowed). Example: to start Word, type: !Winword.
Miscellaneous Copy, del, cd, md, rd. For more information, see Appendices :
ILWIS commands.
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The command line can be hidden or shown by opening the Options menu in the
Main window, choose Command line.
For more information, refer to chapter 6 MapCalculation or to the Appendices :
ILWIS commands and Appendices : ILWIS expressions
Pocket line calculator
The command line in the Main window and the command line of a table window
can be used as a pocket calculator.
Type a question mark on the command line followed by an expression, i.e. a
combination of constant values and operators or functions. It is allowed to use map,
table and column names in the pocket line calculator.
Examples:
?2+4
? SQRT(64)
? POW(2,8)
? MyFunc(22,44,66)

returns 6
returns 8
returns 256
returns the result of a user-defined function 'myfunc'; the
first three parameters in this function are replaced by values
22, 44, and 66.

Constant value π can be used by typing PI, constant value e can be used by typing
EXP(1).
For more information, refer to sections MapCalc, Pocket line calculator or TabCalc
in Chapter 6.

3.1.5 Main window Button bar
The button bar is located between the command line of the Main window and the
Catalog in the Main window. Buttons in the button bar provide short cuts for some
regularly used menu commands. Buttons can be clicked to invoke a certain action.
When the mouse pointer is located above a button, the status line provides a short
explanation of the effect of the button.

The following actions can be performed:
Show Operation-list button: Hides or shows the Operation-list along the left side of
the Main window.
Show Map button: Opens a raster, segment or polygon map in a new map window
or opens any other ILWIS object. Select a map in the showing dialog box, enter
display options for the map.
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Show Table button: Opens a table in a new table window. Select a table in the
appearing dialog box.
Open Pixel Information window button: Opens the Pixel Information window.
Customize Catalog button: Opens the Customize Catalog dialog box which allows
you to select the object types that are visible in the Catalog.
The button bar can be hidden or shown with menu command Options, Button Bar.

3.1.6 Navigator
The navigator is located to the right of the button bar in the Main window. The
navigator allows you to select another directory or another drive. A picture of the
Main window is presented in Help topic Main window: introduction.
Click one of the list boxes or one of the little buttons with the arrow, and select a
new drive or a new directory. It is advised to access data from the hard disk, not
from floppy drives.

3.1.7 Main window Status line
A status line is located at the bottom of the Main window.
The status line:
n
gives a brief explanation on highlighted menu commands,
n
gives a brief explanation on the effect of buttons in the button bar when moving
with the mouse pointer over a button,
n
displays the description of objects when moving with the mouse pointer over an
object in the Catalog,
n
displays the description of operations when moving with the mouse pointer over
an operation in the Operation-list.

3.1.8 Main window Menu commands
File

Create

Open ...
Open Pixel Information
Switch to
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Create Point Map ...
Create Segment Map ...
Create Raster Map ...
Create Map List ...
Create Table ...
Create Two dimensional Table
Create Domain ...
Create Representation ...
Create Georeference ...
Create Coordinate System ...
Create Sample Set ...
Create Filter ...
Create Function ...
Create Script ...

select window
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Close All
Minimize All
Restore All
Import ...
Export ...
Batch Import from 1.4 ...
Exit
Edit

Edit Object ...
Properties
Copy Object ...
Delete Object ...

Operations

Visualization

Show Map ...
Show Table ...
Color Composite ...
Display 3D ...
Apply 3D ...
Slide Show ...

Raster Operations

Map Calculate ...
Attribute Map ...
Cross ...
Aggregate Map ...
Distance ...
Iteration ...
Area Numbering ...
Sub Map ...
Glue Maps ...
Mirror Rotate ...

Image Processing

Filter ...
Stretch ...
Slicing ...
Color Separation ...
Cluster ...
Sample ...
Classify ...
Resample ...

Statistics

Histogram ...
Raster
Map List

Polygons
Segments
Points

Interpolation
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Densify Map ...
Contour Interpolation ...
Point Interpolation

Autocorrelation ...
Principle Components ...
Factor Analysis ...
Variance-Covariance ...
Correlation Matrix ...
Neighbour Polygons ...
Direction Histogram ...
Spatial Correlation ...
Pattern Analysis ...

Nearest Point ...
Moving Average ...
Moving Surface ...
Trend Surface ...

35

ILWIS window types

Vector Operations

Unique ID
Polygons

Segments

Points

Options

Rasterize

Polygon to Raster ...
Segment to Raster ...
Segment Density ...
Point to Raster ...
Point Density ...

Vectorize

Raster to Polygon ...
Raster to Segment ...
Raster to Point ...
Polygon to Segment ...
Polygon to Point ...
Segment to Polygon ...
Segment to Point ...

Table Operations

Transpose Table ...

Catalog ...
√ Active
Digitizer
√ Command Line
√ Operation-List
√ Button Bar
√ Status Line

Help
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Attribute Map ...
Mask Polygons ...
Assign Labels ...
Transform Polygons ...
Attribute Map ...
Mask Segments ...
Assign Labels ...
Sub Map ...
Glue Maps ...
Densify Coordinates ...
Transform Segments ...
Tunneling ...
Attribute Map ...
Mask Points ...
Sub Map ...
Glue Maps ...
Transform Points ...
Transform Coordinates

Map Reference
Digitizer Set-up

Help on this Window
Contents
Search
Index
Glossary
Operations
Menu Commands
How to ...
How to use Help
About ILWIS
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3.1.9 Main window Mouse functions
Both the Catalog and the Operation-list are very sensitive to clicking, doubleclicking and drag and drop actions. Using the Catalog and Operation-list
capabilities is far more efficient than using menus.
Moving with the mouse over
n
A command on a menu: the status line displays information that helps explain
the task of the highlighted menu command; Highlight a menu command by
opening a menu and drag the mouse pointer along the commands on the menu.
You can also use the Up Arrow and Down Arrow keys on the keyboard to move
through the commands on a menu;
n
A button in the button bar: the status line gives a short explanation of the
function of the button;
n
An object in the Catalog: the status line displays the description of the object;
n
An operation in the Operation-list: the status line gives a brief explanation on
the operation.
Clicking
n
A button in the button bar: performs the action of the button.
Double-clicking
n
A map, table and most other objects in the Catalog: the object is opened in a
new window;
n
A filter in the Catalog: starts the Filter operation, the Filter dialog box is
displayed;
n
A script in the Catalog: starts to run the script;
n
An operation in the Operation-list: the operation's dialog box appears;
n
Another directory or drive in the Catalog, changes the current directory or
drive;
Drag
n
A raster, polygon, segment, or point map from the Catalog to an existing map
window: adds the map as an extra data layer to the map window. It is not
possible to display two raster maps in one map window;
n
A raster, polygon, segment, or point map from the Catalog to an existing pixel
information window: adds the map to the pixel info window. When an attribute
table is linked to the map, the attribute values also appear;
n
A data object from the Catalog to an operation in the Operation-list: the dialog
box of that operation appears with the data object specified as input for the
operation;
n
An object from the Catalog to a drop-down list box in an opened dialog box of
an operation: the object is put in the box.
Clicking the right mouse button
n
On an object in the Catalog: a context-sensitive menu appears from which you
can select an operation that you want to perform with this object, or a command
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n

such as Open, Edit, Properties, Copy and Delete. You can also select Help from
the context-sensitive menu to obtain short Help on the selected object type;
On an operation in the Operation-list: a context-sensitive menu appears from
which you can select Run to start the operation, or select Help to obtain short
Help on the selected operation.

For more information, refer to section 8.36.1 How to use the Catalog.

3.2 Map window
3.2.1 Introduction
In a map window, you can display a raster map, one or more vector maps, or one
raster map together with one or more point, segment, or polygon maps and
annotation. The different maps in a map window are called data layers. Grid lines,
legend, text and symbols are called annotation layers. You can open as many map
windows as you like. Maps can be edited with the editors. Map windows have a
menu bar, a button bar and a status line.
For information on minimizing, maximizing a map window, using scroll bars etc.,
see section 1.2.1 Introduction on Windows features.

3.2.2 Functionality
A map window can display multiple maps and annotation, for instance:
n
a raster map with one or more point maps, segment maps, polygon maps, and
annotation, or
n
a segment map with one or more point maps, other segment maps, polygon
maps, and annotation, etc.
When multiple maps are displayed in the same map window, the different maps are
called data layers. You can also have annotation layers. It is not possible to display
two or more raster maps in the same map window. You can open as many map
windows on the screen as you like.
A map window contains a menu bar, a button bar and a status line. Besides
displaying, you can also edit maps in a map window.
To open a new map window
A map window can be opened, by opening the File menu in the Main window, and
choosing the Open command, by double-clicking a map in the Catalog, or by
choosing the Open Map Window command from the File menu in an existing map
window. You can also use the open button in the button bar of the Main window, or
the Show command in the Operation-list. Before a map is actually displayed, some
display options have to be specified. In the Catalog, maps are preceded by the
following icons:
raster maps,
polygon maps,
segment maps,
point maps.
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To display one or more data and annotation layers in the same map window
You can add data and annotation layers to a map window by opening the Layers
menu, and choosing the Add Data Layer or the Add Annotation command. As
annotation, you can add: text, legend, scale bar, North arrow, grid lines, graticule,
boxes, etc. You can also drag a point, segment, polygon, or raster map from the
Catalog to the map window. Display options have to be specified. In the display
options dialog box of maps with an attribute table, you can choose to display a map
by one of its attributes. When a second raster map is added to a map window which
already contains a raster map, the second raster map replaces the first.
To get info on data layers and attributes
Pressing the left mouse button at a position of interest in the map window, shows
information on a data layer. When, for example, a satellite image is displayed in
the map window, you will see the pixel value at the current mouse position. When a
rasterized polygon map is displayed that contains for example land use classes, you
will see the names of the land use classes. When pointing to a segment, or point in
a map window, the code of the segment or the name of the point is displayed. To
see information on a data layer it is necessary that the 'Info' check box is marked in
the Display Options dialog box of the layer. You can also turn 'Info' on by opening
the Layers menu and choosing Layer Management.
When a map window displays multiple data layers and you click somewhere in the
map window to get info, a search is performed at the position of the mouse pointer
through all layers (from top to bottom) that are displayed in the map window, and
of which the Info check box is selected. When in the first layer a class name,
identifier, value or a color is found, it is displayed next to the mouse pointer. When
an undefined value is found, the search continues in the next layer. If in a raster
map no class name, identifier, value or color is found, a question mark is shown. If
in a vector map no class name, identifier, or value is found, nothing is shown.
When a map is shown by one of its attribute values, Info shows the class name or
identifier and the attribute value of this class name or identifier.
When an attribute table is linked to a map or its domain (class or ID domain), you
can double-click at a position of interest to retrieve the attributes from the attribute
table. The action performed while double-clicking is determined by the DoubleClick Action command on the Layers menu. See also Map window : functionality
(advanced).
F
F

Window and in the map editors by setting the 'width' in the properties of the
domain. The default width for a class domain is 15, the default width for an
identifier domain is 6.
To inspect all meanings and/or values of multiple maps and attribute data, you can
open the pixel information window.
To zoom in on maps
There are several ways to zoom in on maps: you can select the Zoom In command
on the Options menu, or you can click the Zoom In button in the button bar. You
can also press the Ctrl+I keys on the keyboard, or choose the Select Area command
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on the context-sensitive menu which appears when clicking the right mouse button
in the map. If you zoom in very deeply on a raster map, the values or meanings of
pixels appear inside the pixels of your map. There are similar ways to zoom out and
to display the entire map again: use the Zoom Out or Entire Map commands on the
Options menu, use the Zoom Out button or Entire Map button in the button bar, or
press the Ctrl+O keys on the keyboard.
Zoom In:

When you choose Zoom In from the menu or from the button bar: the
mouse pointer changes into a magnifying-glass. Click somewhere in the
map to zoom in on this spot, or drag the mouse pointer from one corner
of interest to another (the pointer changes into a little box).
Ctrl+I:
Zooms in with factor 2 on center of map.
Zoom Out: Zooms out directly from the center of the displayed map with a factor 2.
Scrolling through a map window
When you zoom in on a map, scroll bars will appear at the right and bottom side of
the map window. You can use the scroll bars in the normal way with the mouse
(see Help topic Windows features : introduction), but you can also use the following
key combinations:
n
PageUp, PageDown, Home, or End to scroll up, down, to the left or to the right,
or
n
Ctrl+PageUp, Ctrl+PageDown, Ctrl+Home and Ctrl+End to scroll vertically to
the top line, bottom line, and to scroll horizontally to the first column and last
column.
To move the mouse pointer exactly one screen pixel up, down, to the left, or to the
right, you can use the Arrow keys on the keyboard.
To change representation
If you are not satisfied with the current colors of the map in your map window:
n
you can create a new representation for domain Class maps, domain Value
maps, and Images in the Display Options dialog box of the map, or
n
when the map window displays a map which uses a user-defined representation,
you can also open Edit menu and choose Representation.
The representation of a map depends on the domain of a map. For more
information see Help topic How to use Representations. For domain Class maps,
you can also set the double-click action to Edit Representation (Layers menu);
double-clicking in the window then allows you to edit colors directly.
To edit maps
To edit maps you can start one of the editors. In raster, polygon, segment and point
maps, the IDs, class names or values in these maps can be edited, depending on the
domain of the map. In polygon maps, the position of coordinates within polygon
boundaries can be edited and in segment maps the position of coordinates within
segments. Furthermore, new polygons, segments or points can be inserted with or
without using the digitizer. Dependent maps cannot be edited, first break the
dependency links.
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To view or edit attributes
When a map is of the domain type Class or ID, and an attribute table is linked to
the map (see the properties of the map, or the properties of the domain), attributes
can directly be viewed and edited by double-clicking in the map. Note that the
action performed by double-clicking is determined by the Double-click action
command on the Layers menu.
Other functionality
n
The background color of maps displayed in a map window can be changed by
selecting Background Color from the Layers menu.
n
The size of a map window can be increased or decreased by selecting the Extend
Window command from the Options menu. This is useful if you want to add
annotation.
n
The distance and angle between two points in a map window can be measured
by selecting the Measure Distance command from the Options menu or by
clicking the Measure Distance button in the button bar.
n
The coordinate system or georeference used by a map window can be changed
by selecting Coordinate System from the Options menu. This is useful to display
map(s) with different coordinate systems.
To save multiple layers as a view
When you have displayed more than one data or annotation layer in a map window,
you can save the contents of this window as a map view. When a map view is
opened later, all the layers in the map view are directly displayed in one map
window without any display options being asked.
To print a map window
See also How to print a map and annotation.
To close a map window
In Windows 3.1, close a map window by double-clicking the Control-menu box in
the upper-left corner of the map window. Or select the Close command on the
Control menu which appears by clicking the Control-menu box.
Double-click actions
For maps (raster, polygon, segment and point) of the domain Class type, three
double-click actions can be defined. For maps of the domain ID type, two doubleclick actions can be defined. The third double-click action especially, may give
spectacular effects.
1. Change the color of a mapping unit when a mapping unit in a domain Class
map is double-clicked.
2. View and/or edit attributes of a mapping unit when a mapping unit in a domain
Class map or an element in a domain ID map is double-clicked. Attributes
should be stored in an attribute table that is linked to the map
3. Show another map, a GIF image, a bitmap, play a sound or a video, etc. when a
mapping unit in a domain Class map or an element in a domain ID map is
double-clicked. In an attribute table linked to the map, a column Action using
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the String domain should be defined. In this Action column, you specify a file
name of a map or table and its extension (.MPR, .MPA, .MPS, .MPP, .TBT), or
a GIF image, picture, sound or video that you want to see/hear while doubleclicking a mapping unit in a domain Class map or an element in a domain ID
map.
Windows' File Manager should be used to associate non-ILWIS files with a
program that can open these files. Native ILWIS extensions are already
associated with ILWIS during the Set-up of ILWIS. Associations can be found
in the WIN.INI file.
The double-click action first searches for a value that is not undefined through
all layers (from top to bottom) that are displayed in the map window, and of
which the Info check box is selected. You can see which value is found when
you press the left mouse button in the map window (Info). The Info check box
can be selected in the Display Options dialog box of each map or in the Layer
Management dialog box.
1. To edit the representation by double-clicking
n
From the Layers menu, choose Double-click action, and
n
select Edit Representation in the dialog box.
When you double-click in the map window and a class name is found, then a Color
dialog box appears in which you can select another color for this class.
Redraw
the map to apply the changes. If another non-undefined value is found,
nothing happens.
2. To edit attributes by double-clicking
n
From the Layers menu, choose Double-click action, and
n
select Edit Attributes in the dialog box.
When you double-click in the map window and a class name or an identifier is
found, and an attribute table is available, then the attributes of this class or
identifier are shown in a separate window. You can also edit the attributes there. If
no attribute table is found, or if another non-undefined value is found, nothing
happens.
3. To perform an action by double-clicking
n
From the Layers menu, choose Double-click action, and
n
select Execute Action in the dialog box.
Make sure that:
- an attribute table is linked to the map,
- this attribute table has a column Action (column of domain String type)
- you have typed in this column file names inclusive path and extension of the
map, table, GIF image, picture, sound or video that should be opened when
you double-click a certain mapping unit or element,
- you used the Windows 3.1 File Manager (File menu, Associate) to associate
non-ILWIS extensions with a program that can open files with these
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extensions. In Windows '95, this can be achieved using the Open With
command on the File menu.
When you double-click in the map window and a class name or identifier is found,
and the double-click action is set to Execute Action, and an attribute table is found
with a column Action in which a filename is found that has a known association,
then that file is opened (map or table is shown, audio or video is played, etc.). If
another non-undefined value is found, nothing happens.
Display a map list as a slide show
A map window can show multiple raster maps like a slide show. All maps that you
want to show need to be combined in a map list, then the maps in the map list are
displayed one by one in a map window at a user-specified rate. Create a map list of
the maps that you want to show. Then, open the map list for instance by selecting
Open from the context-sensitive menu when clicking the map list in the Catalog, or
by double-clicking the Slide Show item in the Operation-list, or by using the
Operations menu in the Main window.
In a slide show, only one set of Display Options will be used; the defaults are based
on the first map in the map list. The parameters set for this map define the display
options for the other maps in the map list. Specify the number of images you want
to see in the map window in the Display Options - Map List dialog box.
For more information, see How to display a map list as a slide show.

3.2.3 Map window Button bar
The button bar is located just below the menu bar of a map window. Buttons in the
button bar perform short cuts for some regularly used menu commands. Buttons
can be clicked to invoke a certain action. When the mouse pointer is located on a
button, the status line provides a short explanation of the effect of the button.

The following actions can be performed:
Entire map: Displays the entire map in the map window.
Zoom In: Zooms in with a factor of 2 on a selected spot or area in the map. The
mouse pointer changes into a magnifying-glass. Click somewhere in the map to
zoom in on this spot, or drag the mouse pointer from one corner of interest to
another (the pointer changes into a little box).
Zoom Out: Zooms out directly from the center of the displayed map with a factor 2.
Larger: Enlarges the size of the window with a factor 2. If the enlarged window
would not fit on your screen, this button is empty.
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Smaller: Reduces the size of the window with a factor 2.
Redraw: Redraws the contents of the map window. Press Esc to stop redrawing.
Measure Distance: Allows you to measure the distance and the angle between two
points in the map window.
The button bar can be hidden or shown with the Button Bar command on the
Options menu. If an action of a certain button cannot be performed at a certain
moment, the button appears gray.

3.2.4 Map window Status line
A status line is located at the bottom of each map window.
The status line:
n
gives a brief explanation on highlighted menu commands,
n
gives a brief explanation on the functionality of buttons in the button bar,
n
displays the X and Y coordinate information depending on the position of the
mouse pointer in the map window,
n
displays Row and Column numbers when a raster map is displayed, and
n
displays geographic coordinates when the coordinate system used by a point,
segment or polygon map, or by a georeference of a raster map, has projection
information.
For more information, see Help topic How to use the status line

3.2.5 Map window Menu commands
File

Create

Create Point Map ...
Create Segment Map ...
Create Raster Map ...
Create Sample Set ...
Create Georeference ...

Save View
Save View As ...
Save Raster Map As ...
Open Map Window ...
Open Pixel information
Print ...
Printer Set-up
Exit
Edit

Copy
Paste
Edit Layer
Edit Other Map

Annotation
Properties
Representation
Domain
Georeference
Coordinate System
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select layer
Pixel Editor ...
Point Editor ...
Segment Editor ...
Polygon Editor ...
select layer
select layer
select layer
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Layers

Add Data Layer

Add Annotation

Options

Display Options
Layer Management
Background Color ...
Double-Click Action ...
Entire Map
Zoom In
Zoom Out
No Zoom
Redraw
Measure Distance
Larger
Smaller
Extend Window

Raster Map ...
Segment Map ...
Polygon Map ...
Point Map ...
Text ...
Legend ...
Grid Lines ...
Graticule ...
Box ...
Scale Bar ...
North Arrow ...
Bitmap or Picture ...
select layer

Extend by Percentage ...
Extend by Coordinates ...

Coordinate System ...
√ Adjust Window Size
√ Button Bar
√ Status Line
Help

see Main window

Context-sensitive menu
Select Area
Layer Management ...
Double-Click Action ...
layers

3.2.6 Map window Mouse functions
Moving with the mouse over
n
A map in a map window: the status line displays XY-coordinates when a raster
map in the map window has a georeference other than georeference None, and
when vector maps in the map window have a coordinate system other than
coordinate system Unknown; When the map window contains a raster map, also
row and column numbers of the raster map are displayed. When the maps in the
map window have a coordinate system with projection information, the status
line also shows the coordinates in LatLon-coordinates;
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n

n

A command on a menu: the status line displays information that helps explain
the task of the highlighted menu command. Highlight a menu command by
opening a menu and drag the mouse pointer along the commands on the menu.
You can also use the Up Arrow and Down Arrow keys on the keyboard to move
through the commands on a menu;
A button in the button bar: the status line gives a short explanation of the
function of the button.

Clicking
n
A map in a map window: the class names, IDs or values in the map are
displayed depending on the domain of the map. To retrieve information of a
map layer, make sure that the Info check box is selected in the Display Options
dialog box of that layer;
n
A button in the button bar: performs the action of the button.
Continuously pressing the left mouse button
n
On a map in a map window: continuous display of class names, IDs or values of
the data layers information in the window of which the Info box is marked.
Double-clicking
n
A map in a map window: allows you to edit the attributes of this selection if an
attribute table is linked to the map, or allows you to edit the colors of this
selection. Choose the Double-Click Action command on the Layers menu to
select to edit attributes or colors.
Clicking the right mouse button
n
On a map in a map window: a context-sensitive menu appears. You can choose
Select Area, Layer Management or Double-Click Action. Further, you can select
a layer of this map window to change its display options.

3.3 Table window
3.3.1 Introduction
A table window displays one table, a histogram or a two-dimensional table. A table
may be displayed as a regular table or record by record. A table consists of columns,
records and fields. You can edit the contents of the table, change the order of
columns, sort the table, perform calculations on the values in the table, copy the
contents of the table to the clipboard, create graphs from the table data, etc. You
can open as many table windows as you like.
A table window has a command line, located just below the menu bar, on which
you can enter your Table calculation formulae.
For information on minimizing or maximizing a table window, using scroll bars
etc., see the Introduction on Windows features topic.
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3.3.2 Functionality
A table is displayed in a table window. Each table window displays one table. A
table consists of columns, records and fields. A table can be displayed in two ways:
as an overview of the whole table (Table View)and record by record (Record
View).You can open as many table windows on your screen as you like.
A table window has a command line on which you can enter your table calculation
statements. A status line is located at the bottom of a table window; it gives short
information on highlighted menu commands and it may give additional
information when the mouse pointer is located at a certain position in the table
window.
When a table in Table View, record names appear on (gray) record buttons that are
arranged along the left side of the table. If the table is an attribute table, the record
buttons show the class names or IDs of the map to which this table relates. If the
table is not an attribute table, record numbers appear on the record buttons. Further,
column names appear on (gray) column buttons that are arranged along the top of
the table, just below the command line and the menu bar. The record and column
buttons in a table window are sensitive to clicking, double-clicking and drag-anddrop actions.
Normally, a table window displays a table, a histogram, or a two-dimensional table.
Advanced users can also open objects that are internally stored as tables (point
maps; class, ID, and picture domains; class representations; georeference tiepoints)
as tables. You can then edit and calculate with the table-owned columns. For more
information, see How to open objects as a table. For more information on creating
new tables, see How to create a table.
To display existing tables in a table window, see How to display maps and tables.
To switch between Table View and Record View
When a table is opened, you see the table as a whole (Table View). If the table is
too large for the window, scroll bars appear. The table can also be shown record by
record (Record View).
To go to Record View:
n
choose the Record View command on the Options menu,
n
click the Switch View button (the upper left gray button in the table), or
n
click a specific record button in the table.
In Record View, you can use the forward (> and >>) and backward (< and <<)
buttons to go to the next or previous records.
To return to Table View:
n
choose Table View on the Options menu,
n
click the Switch View button in the upper left button, or
n
press Esc on the keyboard.
ILWIS Reference Guide

47

ILWIS window types
To go to a specific record or column
In Table View, open the Options menu, choose Goto Record or Goto Column.
Select a record or a column and the table window will scroll to that record or
column. In Record View, open the Options menu, choose Goto Record. Select a
record and the table window will display that record.
To edit a table
A table can be edited in Table View and in Record View. For fields in columns that
use a value or identifier domain, you can select a field by clicking it with the mouse
pointer and directly start typing. For fields in columns that use a class domain, you
can select a field and then select a class name from the drop-down list. For more
information, see How to edit a table.
If you want to edit a lot of fields in the table, it is advised not to use the Enter key
on the keyboard, instead:
n
to move downward or upward in the table to edit other fields, press the Down
Arrow or Up Arrow keys on the keyboard,
n
to move to the right in a table to edit other fields, press the Tab key on the
keyboard,
n
to move to the left in a table to edit other fields, press the Shift+Tab keys on the
keyboard.
Whenever you move to another field, the previously edited field is directly stored on
disk. You can stop editing by pressing Enter or Esc.
Only fields of source columns can be edited; you cannot edit fields of dependent
columns, fields of table-owned columns that store the results of a calculation or an
operation in a dependent table and fields of read-only columns. For more
information, see ILWIS objects : columns.
Calculations
You can calculate with columns by typing expressions on the TabCalc command
line. The command line is located just below the menu bar. For more information,
refer to Table Calculation. In TabCalc, some 50 internal functions are available, but
you can also define your own functions. Further, you can also use the command line
as a pocket line calculator, by starting an expression by a question mark. Through
the Columns menu, there are possibilities to perform aggregations and joins but
these can also be performed through the command line.
Column Management
On the Columns menu, use the command Column Management:
n
to add and delete columns,
n
to change the properties of a column: change the number of decimals shown for
a value column, change the width of a column, or change the expression of a
dependent column,
n
to change the order of columns,
n
to view whether dependent columns are up-to-date; if not, you can make
columns up-to-date.
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There are also some short cuts available using the keyboard and the mouse, see
Help topic How to use columns.
To add and delete records
If the table is an attribute table, records are part of a domain that is used by the
table and that is used by the map to which the table refers. To add a record to an
attribute table which uses a domain Class or ID, you have to add a class name or
identifier to that domain in the Domain Class/ID editor. To delete a record from a
table which uses a domain Class or ID, you have to delete an item from that domain
in the domain Class/ID editor (not advised).
To sort records
Open the Columns menu and choose Sort. You can sort on the domain and sort on
a column.
To copy (part of) the table into the clipboard
Open the Edit menu in the table window and select the Copy command. For more
information refer to Copy table selection to clipboard. Use the Paste option in
another Windows application to paste this selection into the other application.
To print a table
Open the File menu in the table window and select the Print command. You can
print the entire table or a selection of the table, and you can select the font for
printing.
See also: section 6 Table calculation and section 8.36.2 How to use columns

3.3.3 Table window Command line
The command line of a table window is located at the top of a table window, just
below the menu bar.
The command line of a table window is used to perform calculations with tables
and columns. Type your table calculation statements on the command line.
Further, the command line in a table window can be used as a pocket line
calculator.
F

The command line in each table window has a history: use the Arrow Up key to
retrieve previously used expressions.
The command line can be hidden or shown with the menu command Options,
Command line.
Pocket line calculator
The command line in the Main window and the command line of a table window
can be used as a pocket calculator.
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Type a question mark on the command line followed by an expression, i.e. a
combination of constant values and operators or functions. Map, table and column
names are not allowed in the pocket line calculator.
Examples
?2+4
? SQRT(64)
? POW(2,8)
? MyFunc(22,44,66)

returns 6
returns 8
returns 256
returns the result of a user-defined function 'myfunc'; the
first three parameters in this function are replaced by
values 22, 44, and 66.

Constant value π can be used by typing PI, constant value e can be used by typing
EXP(1).

3.3.4 Table window Status line
A status line is located at the bottom of each table window.
The status line:
n
gives a brief explanation on highlighted menu commands,
n
gives a brief explanation when the mouse is located on a gray button:
- records: click to see and edit the record,
- column names: double-click to change column properties,
- upper left gray 'field': click to change to Record View, or to Table View.
n
gives a brief explanation when the mouse is located on a field in the table field:
click to edit this field.
For more information, see Help topic How to use the status line.

3.3.5 Table window Menu commands
File

Create

Create Table ...
Create Function ...

Open Table ...
Print ...
Printer Set-up
Exit
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Edit

Copy
Paste
Delete
Select All
Properties ...
Edit Field

Column

Add Column ...
Column Management
Sort ...
Update All Columns
Join ...
Aggregation ...
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Options

Help

Cumulative ...
Least Squares ...
Record View
√ Table View
Show Graph ...
Rose Diagram ...
Confusion Matrix ...
Goto Record ...
Goto Column ...
√ Command Line
√ Status Line
See Main window

Menu commands - Graph window
File

Print ...
Printer Set-up
Exit

Edit

Copy Graph

Graph

Add Graph ...
Graph Management
Grid Lines

Options

Redraw Graph
√ Status Line
Legend

Help

See Main window

3.3.6 Table window Mouse functions
Moving the mouse pointer over
n
A column button: the status line gives a hint to double-click the column in order
to edit the column properties. The status line also shows the column name and
its description;
n
A record button: the status line gives a hint to click the record name and go to
Record View;
n
A field in the table: the status line gives information on the column name and
the description of the column;
n
The Switch View button (upper left gray button): the status line gives a hint to
click the button to switch between Table View and Record View.
Clicking
n
A field: allows you to edit the field. Editing fields is only possible when the
column is not a dependent column;
n
A column button: selects the column. You may copy columns into the clipboard;
n
A record button: when in Table View: shows the selected record in Record
View;
n
The Switch View button: switches from Table View to Record View and vice
versa.
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Double-clicking
n
A column name: the Column Properties dialog box appears. In case of
dependent columns created by an earlier TabCalc expression, you can set or
change the TabCalc expression to redefine and/or recalculate the column. You
can also set or change the column's domain, value range, precision, etc. in this
dialog box. Further, for any column type, you can change the position of the
column in the table, or set or change the width of the column. In case of a value
column, you can also set or change the number of decimals shown.
n
To the right of the last column button: the Add Column dialog box appears.
Dragging
n
A line separating column buttons: changes the width of the column (the
appearance of the mouse pointer changes to a double-sided arrow when you are
at the right position to start dragging);
n
A column name to another position: moves the column to another position in
the table;
n
The mouse pointer over a number of fields: select these fields. You may copy
the selection into the clipboard or print the selection;
n
The mouse pointer over a number of records: selects these records. You may
copy the selection into the clipboard or print the selection.

3.4 Pixel information window
3.4.1 Introduction
Pixel info allows you to interactively inspect class names, IDs or values in one or
more raster, polygon, segment and point maps and attribute values in attribute
tables.
First, the pixel information window receives the XY-coordinate from the mouse
pointer (located in a map window) or the digitizer cursor (located on a referenced
paper map on the digitizer). Then, for this received coordinate, information of all
raster, polygon, segment and point maps that were added to the pixel info window
is retrieved and displayed simultaneously. For raster maps, the retrieved
information refers to the pixel pointed at with the mouse pointer, hence pixel info.
Open the pixel information window, add maps to the pixel info window (when an
attribute table is linked to a map or a domain these are also added), and move the
mouse pointer through a map window. The pixel info window displays:
n
the XY-coordinate of the position of the mouse pointer in the map window;
n
class names, IDs or values found in the maps at that position;
n
attribute information found in attribute tables.
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Example

In this example the following information is retrieved for the current XYcoordinate:
n
class name of polygon map Geology, and attribute information found in
columns gelatine, Lithology, and GeolAge,
n
value of raster map Slopepct,
n
class name of polygon map LandUse,
n
class name of polygon map Geomorph, and attribute information found in
columns Description and Slides.
Whether pixel info displays class name, IDs or values of maps depends on the
domain(s) of the maps.
Attributes from an attribute table are retrieved when:
n
the domain of a map is a class domain or an identifier domain, and
n
the domain of the attribute table is the same as the domain of the map to which
it relates, and
n
the attribute table is linked to the map or to the domain of the map.
The advantage of using pixel info, above using the left mouse button in a map
window (Info), is that you can get information on several maps at the same time
and also on attribute values.
For information on minimizing or maximizing the pixel information window,
using scroll bars, etc., see Introduction on Windows features.

3.4.2 Pixel info window Functionality
The pixel information window allows you to interactively inspect class names, IDs
or values in multiple raster, polygon, segment and point maps with the same or a
compatible coordinate system.
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When one map is displayed in a map window, the pixel information window is
capable of retrieving values of all maps added to the pixel info window, at the
position of the mouse pointer in the map window. In the same way, when you have
an analog paper map on the digitizer and you performed MapReference, the pixel
information window is capable of retrieving values of all maps added to the pixel
info window, at the position of the digitizer cursor.
To the pixel information window, you can add raster maps, polygon maps, segment
maps and point maps. When an attribute table is linked to one of those maps or to
the domains of the maps, the attribute information is also shown.
The pixel information window is used to gain an insight into your models.
Also, when only the object definition file of a dependent map exists, pixel info is
able to actually calculate output values of the maps on the fly. This is possible for
all output maps of MapCalc, and for output maps of the Classify, Densify, Filter,
Slicing and all Attribute Map operations.

n

n

Examples
Create a number of dependent output maps with MapCalc, use slightly different
formulas, do not mark the Show check box in the dialog boxes; display an input
map in a map window; drag the dependent output maps to the pixel information
window, and check the results of the formula's used in the different maps.
During Sampling, you can already create some dependent output maps with the
Classify operation (various methods, various parameters) using the current
sample set as input. When creating the dependent output maps, do not mark the
Show check box in dialog boxes; just create the definition for the output maps.
In this way the dependent output maps exist only by their object definition file
and are not yet calculated and stored on disk. If you then add these dependent
maps to the pixel info window, you can already see the results of classifying
during sampling.

Working with dependent maps which merely exist by their object definition file
saves calculation time and disk space. Only when the maps are displayed in a map
window, the calculation starts and the output pixel values are stored on disk.
General method to use Pixel Information
n
display a map in a map window,
n
open the pixel information window,
n
add maps to the pixel info window (see below),
n
move the mouse pointer through the map window, or move the digitizer cursor
over a referenced paper map on the digitizer.
The pixel info window will display:
n
the received XY-coordinate of the position of the mouse pointer in the map
window, or of the digitizer cursor on the digitizer,
n
the retrieved class names, IDs, or values of the maps added to the pixel info
window at that position,
n
attribute information of these class names and IDs found in the attribute tables.
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The pixel info window either displays this information continuously for each
position of the mouse pointer in the map window, or only when you click with the
mouse pointer in the map window. This depends on the settings of the Continuous
check boxes in the Customize Pixel Info dialog box.
In case a map window only displays a raster map with georeference None, the pixel
info window displays the Row and Column numbers of the actual mouse position.
To open the pixel information window
From the File menu in the Main window or a map window, choose Open Pixel
Information. Or click the Pixel Information button in the button bar of the Main
window.
To add maps to the pixel information window
From the File menu of the pixel information window, choose the command Add
Map. Then select the raster, polygon, segment and/or point maps which you want
to add one by one. You can also drag maps from the Catalog into the pixel
information window. If an attribute table is linked to a map or to the domain of a
map, the attribute information is also shown. You can check whether an attribute
table is linked to a map or a domain in the Properties dialog box of the map or the
domain.
To hide or show maps and attributes in the pixel info window
From the Options menu, choose Customize. You can also click on the upper left
gray area in the pixel info window. The Customize Pixel Info dialog box appears
which displays a list of maps, tables and columns. By clicking in this list, maps and
columns can be (de-)selected; selected items appear highlighted and will be shown
in the pixel info window.
Detailed pixel info by using the keyboard
To move the mouse pointer in the map window and see the result in the Pixel info
window, you can use the Arrow keys on the keyboard to move 1 screen pixel, or use
the Ctrl+Arrow keys on the keyboard to move 10 screen pixels.
Retrieved information
n
for raster maps: the class name, identifier or value of the pixel;
n
for polygon maps: the class name, identifier or value of the polygon;
n
for segment maps: the class name, identifier or value of the nearest segment;
n
for point maps: the class name, identifier or value of the point.
If no class name, identifier or value is found in a pixel or polygon, undefined (?) is
returned. Also, if in a point map you click outside a point, undefined is returned.
Further,
n
for maps using a Picture or Color domain, the color is returned as (Red, Green,
Blue);
n
for maps using a Bool domain, True or False is returned;
n
for maps using a Bit domain, 0 or 1 is returned, etc.
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Closing the pixel information window
Close the pixel information window by double-clicking the Control-menu box in
the upper-left corner of the window. Or click the Control-menu box: the Control
menu is opened, choose Close. The size and position on the screen of the pixel
information window is automatically saved in the ILWISCFG.INI file.
Similar functionality
In the pixel information window you can get information on maps which are not
necessarily displayed, and you can get attribute information from a table that is
related to a map.
With map info you can only get information on different data or annotation layers
which are displayed in one map window. For map info, press the left mouse button
in a map window. Be sure that the Info check box on the layer's Display Options
dialog box is marked.

3.4.3 Pixel info window Status line
A status line is located at the bottom of the pixel information window.
The status line:
n
displays brief information on highlighted menu commands,
n
gives a brief explanation when the mouse is located on a gray area:
- upper left gray 'field': Customize the pixel information window,
- map and column names: map name and extension (.MPR, .MPA, .MPS,
.MPP) or column name and extension .CLM,
- retrieved information fields: the information as retrieved for this coordinate
from this map or column is repeated.
n
gives a brief explanation when the mouse is located on a field in the table field:
click to edit this field.

3.4.4 Pixel info window Menu commands
File

Add Map ...
Add Coordinate System ...
Print ...
Printer Set-up
Exit

Edit

Copy

Options

Customize
√ Always on top
√ Status Line

Help

See Main window

3.4.5 Pixel info window mouse functions
The mouse pointer can be located either in a map window, then the pixel
information window shows current coordinate and retrieved information for the
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maps (and tables) added to the pixel info window at this coordinate, or the mouse
pointer can be located in the pixel information window itself.
Mouse pointer located in a map window
Moving the mouse over
n
The map in the map window: if the pixel information is customized to
continuously receive coordinates from the mouse, the pixel information window
returns the XY-coordinate of the current position of the mouse pointer in the
map window. Subsequently, the pixel info window retrieves at that coordinate
the class names, identifiers and/or values of the maps (and tables) added to the
pixel info window.
Clicking
n
The map in the map window: if you cleared the continuous check box for the
mouse pointer in the Customize Pixel Info dialog box, the pixel information
window returns at a click in the map window the XY-coordinate of the current
position of the mouse pointer in the map window. Subsequently, the pixel info
window retrieves at that coordinate the class names, identifiers and/or values of
the maps (and tables) added to the pixel info window.
Mouse pointer located in the pixel information window
Moving the mouse over
n
Map and column names: the status line shows the map name and its extension
(.MPR, MPA, MPS, MPP) or the column name and the extension .CLM;
n
Coordinates and retrieved information from maps and tables: the status line
repeats the information.
Clicking
n
The upper left gray field: the Customize Pixel Info dialog box appears;
n
The gray button above the coordinates and retrieved values: selects the current
coordinate and retrieved information for this coordinate. You may copy this to
the clipboard;
n
A gray map name or column name: selects the map (or column) name and the
retrieved value for this position. You can copy this to the clipboard. Hold the
Shift key down to select multiple map and column names and their retrieved
values;
n
A retrieved value: selects this value. You can copy this to the clipboard. Hold
the Shift key down to select multiple retrieved values.
Dragging
The line between the upper left gray field and the gray button above the coordinates
and retrieved values: changes the width of the column containing the map and
column names. The appearance of the mouse pointer changes to a double-sided
arrow when you are at the right position to start dragging.
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